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Log on to ONEPeralta
Sign in

All ONEPeralta Users

1. Enter into your browser > one.peralta.edu
2. Enter > Peralta email User ID and Password
3. Click > Sign In

ORACLE
PEOPLESOFT

Password

Select a Language

English

M Enable Screen Reader Mode

Set Trace Flags

ﬁ Due to periodic system improvements and your evolving role within
the system, the screenshots in this training may be different from
Note what you will see when you log in to ONEPeralta.
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Log on to ONEPeralta (cont'd)
Turn on VPN

All ONEPeralta Users

If you are having trouble logging into to ONEPeralta, you may need to
connect to Peralta’s Virtual Private Network (VPN) before you are able to
log in to ONEPeralta. Follow the steps below to connect to VPN, then try
logging in again.

Turn on VPN using one of two methods:

1. Desktop (recommended method)
a. Open > FortiClient
b. Select > Remote Access
C. Enter > Peralta email Username and Password

222 FortiClient - X
File Help

. FortiClient Console

Compliance

Not Participating

Peralta nonprod -~ |86
Remote Access
No VPN Connected
@ Vulnerability Scan :

Vulnerabilities F

Connect
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Log on to ONEPeralta (cont'd)
Turn on VPN

All ONEPeralta Users

2. Web / Browser
a. Enter into your browser > https://access.peralta.edu/
b. Enter > Peralta email Username and Password

PERALTA Peralta Web VPN
COLLEGES

Access to this portal is restricted to Peralta Community College District employees.

Continue to login ONLY if you are an active employee.

Password:
Login
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https://access.peralta.edu/

Budget Info, Exceptions, & Reports
Review Budget Details

In the upgraded ONEPeralta system, use the following steps to
review the Budget Details.

1. Click > NavBar icon > Navigator

2. Click > Commitment Control > Review Budget Activities > Budget
Details

Requisition

Design Forms

s

Discussione Fryr— NavBar: Navigator o ]
_ #  Review Budget Activities *

Budget Details

Budgets Overview @

Ledger Inquiry Set

E Activity Log

Navigator

Recent Places

My Favorites

Review Fund Source Allocations
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Budget Info, Exceptions, & Reports

Review Budget Details

3. Enter > Business Unit > Ledger Group
4. Click > Search

Budget Details

Enter any information you have and click Search. Leave fields blank for a list of all values.

Find an Existing Value

w Search Criteria @

v | PCCD1 Q

Business Unit

<
jo

Ledger Group

(4)
l Search I Clear Basic Search &P Save Search Criteria
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Budget Info, Exceptions, & Reports
Review Budget Details

5.

Enter ChartFields:

a) Location

b) Fund

c) Cost Center

d) Object Code

e) Program

f) Activity Suffix
g) Project

h) Accounting Line
i) Budget Period

6. Click > Search

7. Click > View Details hyperlink from search results

Budget Detail Overview

Budget Inquiry Criteria

Select Budget Detail

. ; . Fund Cost Object Program Activity . Accounting )
Business Unit Ledger Group Location Code i Code Code Suffix Project Line Budget Period
PCCD1 APPROP Q Q Q Q
Budget Details
B Q 14 | 16306-16320 of 21313 v 4 4] View 100
. . . Fund  Cost Object Program  Activity . Accounting . .
Business Unit Ledger Group Location Code o Code Code Suffix Project Line Budget Period  View Detail 7
16306 PCCD1 APPROP 5 1" 554 4303 1 050600 2045 00 2018 View Details
16307 PCCD1 APPROP 6 01 601 4303 1 660100 0000 00 2018 View Details
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Budget Info, Exceptions, & Reports
Review Budget Details

8. Click > Drill to Ledger icon (

) to view Ledger details

9. View > Ledger information on Ledger page

Commitment Control Budget Details

Business Unit Ledger Group Location
PCCD1 APPROP 5
Display Chart
Ledger Amounts
Budget:
Expense:
Encumbrance:
Pre-Encumbrance:
Associate Revenue
Available Budget
Without Tolerance
With Tolerance
Budget Exceptions
Exception Errors 0

Return to Search Notify

Cost
Fund Ctr
" 554
Previous
0.00

Exception Warnings

Object Activity 9 Accounting -
Code Program Suffix Project s Budget Period
4303 1 050600 2045 00 2018
Next Return to Inquiry Criterig
Max Rows
. . Attributes
0.00 USD S ]
Parent / Children
0.00 USD & <3 Associated Budgets
0.00 USD g <3
0.00 USD g <3
usbD
UsD Percent (0%)A  Forecasts
usD Percent (0%) 7
0 Budget Exceptions

100

Business Unit
Budget Details
5 Q

Budget Chartfields

Location

FUTURE
PERALTA

PCCD1

Amounts

Fund

1

1"

Ledger

Object

Cost Ctr Code

554 4303

554 4303

Ledger

APP_BUD

Program Activity Suffix Project Accounting Line Budget Period

050600 2045 00 2018

050600

2045 00

2018




Budget Info, Exceptions,
Review Budget Details

10. Click > Drill Down icon (%)
11. Click > Amounts tab
12. Click > Show all Columns icon (I»)
13. Click > Show Journal Detail icon

14. Click > OK

& Reports

Ledger X
Business Unit PCCD1 Ledger APP_BUD
Budget Details
5 Q 1202 v
Budget Chartfields Amounts 13
Fund Cost Ctr g:’::‘ Program Activity Suffix Project Accounting Line Budget Period
Q " 554 4303 1 050600 2045 00 2018
1 554 4303 1 050600 2045 00 2018
Budget Journal X
Business Unit PCCD1 Ledger APP_BUD
Budget Details
F Q 120f2 v

Budget Chartfields n
Budget Foreign Amount bl Monetary Amount  Currency Line Descr Entry Type Date Posted
Period Currency

Transfer
2018 -517.00 USD -517.00 USD Subs Periodicals - Other Adjustment 02/07/2018
2018 517.00 USD 517.00 USD Subs Periodicals - Other Original 08/14/2017
OK
Budget Journal x
Business Unit  PCCD1 Ledger  APP_BUD
Budget Details
Date Status Year Period  Line# Location Fund g:" gz{::‘ Program Activity Suffix.  Project Accounting Line
0000064267 020772018 Posted 2018 8 15 1 554 4303 1 050600 2045 00
1805112045 0710172017 Posted 2018 1 65 11 554 4303 1 050600 2045 00
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Budget Info, Exceptions,

Review Budget Details

15. Click > Drill to Activity Log icon (!

16. Click > OK

ONE

Commitment Control Budget Details

. _ . Cost Object Activity 5 Accounting .
Business Unit Ledger Group Location Fund Ctr Code Program Suffix Project i Budget Period
PCCD1 APPROP 5 11 554 4303 1 050600 2045 00 2018

Display Chart 0 Previous Next Return to Inquiry Criteria
Ledger Amounts
Max Rows
- Attributes
Budget: 0.00 USD e
Parent/ Children
Expense: 0.00 USD Y Associated Budgets
Encumbrance: 0.00 USD Y
Pre-Encumbrance: 0.00 USD Y
Associate Revenue 0.00 usb
Available Budget
Without Tolerance 0007  usD Percent (0%)A Forecasts
Activity Log x
Budget Exceptions
Ledger  APP_BUD
Activity Log
Q v
Return to Search
Una Dogamemt  Documentio  BSf,  Location Fund SOt OBt progam bl Project focounting  gudget Period ]
R 299 Joumal ID: 1802SAL N 2 " 243 101 1 453030 1060 00 2018
agal D 18028AL N 2 " 243 1101 1 453030 1060 0 2018
1802SAL N 2 " 23 01 483030 1060 ) 2018
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Budget Info, Exceptions, & Reports
Review Budget Details

17. Click > Attributes hyperlink
18. Click > OK
19. Click > Display Chart button

Budget Detail Attributes X

Control Budget Attributes

Commitment Control Option Control
Tolerance Percent  0.00000000

9

Budget Status Open

Commitment Control Budget Details

Business Unit Ledger Group Location Fund Ctr Code Program Suffix Project Billget Period
PCCD1 APPROP 1 9 5 11 554 4303 1 050600 2045 00 201!
Display Chart Previous Next Return to Inquiry Criteria
Ledger Amounts
" 100
Budget: 0,00 USD PS Y Attributes
a1 Oren

Expense: 0.00 USD & <5 Associated Budgets
Encumbrance: 0.00 USD & <3

Pre-Encumbrance: 0.00 USD & <5

Aty a0 s P et 4 gt ¢ Ara st B |

Availal
) 5 Forecasts
Nl
-
Budgg i .
: tions
Rety

Return to Search Notify
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Budget Info, Exceptions, & Reports
Review Budget Overview

In the upgraded ONEPeralta system, use the following steps to
review the Budget Overview.

1. Click > NavBar icon > Navigator

2. Click > Commitment Control > Review Budget Activities > Budget
Overview

6

(2)

NavBar: Navigator o ]

2 #  Review Budget Activities *

Budget Details

Recent Places

Budgets Overview

My Favorites ;
Ledger Inquiry Set

E Activity Log

Navigator

Review Fund Source Allocations
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Budget Info, Exceptions, & Reportsw

Review Budget Overview

3. Click > Add a New Value
4. Enter > Inquiry Name
5. Click > Add

Budgets Overview

3
Find an Existing Value Add a New Value

Inquiry Name “

’Addj

Find an Existing Value | Add a New Value
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Budget Info, Exceptions, & Reports4

Review Budget Overview

6. Enter > Required Fields:
a) Description
b) Business Unit
c) Ledger Group

7. Enter > Optional Fields:
a) Location
b) Fund
c) Cost Center
d) Object Code
e) Program
f) Activity Suffix
g) Project
h) Accounting Line

Budget Inquiry Criteria
Budget Overview

Inquiry BUD_OVER Description
Amount Criteria Search Clear Reset Ledger/Activity Log Integrity Act Log Internal Integrity
Budget Type
*Business Unit [PCCD1T Q Ledger Group/Set | -&dger Group v Ledger Group |APPROP Q
T r Approgristion Ledger Group
o Display Chart
TimeSpan
*Type of Calendar | Detail Budget Period v
Budget Criteria
H Q 1-10f1 ¥ View All
. . Include Adjustment 5
Select Ledger Group Calendar ID From Budget Period To Budget Period Period(s) Include Closing Adjustments
APPROP AN 2018 Q 2018 Q
ChartField Criteria @S‘a‘us
ChartField Chaifiea B ChartField To Info  ChartField Value Set  Update/Add ’ Open
Object Code aQ aQ o Q pda Closed
Cost Ctr Q Q o Q pda Hold
Fund Q Q (i} Q pdats
Program Q Q (i ] Q
Location a a o Q
Acct Line Q Q o Q pdat
Activity Suffix Q Q o Q pda
Project aQ aQ ° a pda
Save Notify Refresh Add

Update/Display
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Budget Info, Exceptions, & Reports
Review Budget Overview

8. Click > Save
9. Click > Search

Budget Inquiry Criteria
Budget Overview
Inquiry BUD_OVER Description o
Amount Criteria Clear Reset Ledger/Activity Log Integrity Act Log Internal Integrity
Budget Type
*Business Unit |PCCD1 Q Ledger Group/Set | Le9ger Group v Ledger Group |APPROP Q
View Stat Code Budgets Approgriation Ledger Groug
o Display Chart
TimeSpan
*Type of Calendar Detail Budget Penod v
Budget Criteria
BH Q 1-10f1 ¥
s - Include Adjustment : :
Select Ledger Group Calendar ID From Budget Period To Budget Period Period(s) Include Closing Adjustments
’ AFPROP AN 2018 Q 2018 Q ¢
ChartField Criteria Budget Status
ChartField Chartfield From ChartField To Info  ChartField Value Set  UpdatelAdd @ Open
Object Code % Q 0 Q o Q Update/Add 7 Closed
Cost Ctr o Q % Q 0 Q ‘ e
Fund o Q % Q o Q
Program % Q o Q o Q
Location % Q o Q o Q
AcctLine % Q o Q o Q
Activity Suffix E Q [ Q o Q
Project % Q % Q (i} Q
Save Notify Refresh Add Update/Display
O N E el I
PERALTA -




Budget Info, Exceptions, & Re
Review Budget Overview

10. Click > Budget Details icon

Inquiry Results

Return to Criteria
Ledger Totals (100 Rows)

Budget

Expense
Encumbrance
Pre-Encumbrance
Budget Balance
Associate Revenue

Available Budget

Budget Overview Results

5 Q

Ledger Group Location

APPROP 2

Business Unit

Ledger Group

Type of Calendar

Amounts in Base Currency

Revenue Associated:

Max Rows

18,377,848.88

9,578,101.90
0.00
0.00
8,799,746.98
0.00
8,799,746.98
Descrpion  Fund
College of 11
Alameda

PCCD1
APPROP

Detail Budget Period

usb

100

Fund Code
Description

General Restricted
Fund

Display Options

Net Transfers

Cost g
Ctr Department Description
243 Student Services - EOPS

Search

-168,257.20

Object
Code

1101

1-100 of 100 v View All
Account Prog
Description Program Des/
Instructor 1 @

FUTURE
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Budget Info, Exceptions, & Re
Review Budget Overview

11. Click > Drill to Ledger ¢ to view Ledger details
12. Click > Drill to Activity Log = to view Activity Log

Ledger X
Business Unit PCCD1 Ledger APP_BUD
Budget Details
5 Q 110f1 v
Budget Chartfields Amounts >
Location Fund Cost Ctr g:{,e:t Program Activity Suffix Project Accounting Line Budget Period
£} 2 1 243 1101 1 1060 00 2018
UG ErTrS o e
Display Chart ,0:
Ledger Amounts 1 2
Max Rows 100
Budget: 186,52800 USD 5 pubtes
Parent / Children
Expense: 107.67622 USD S Associated Budgets
Encumbrance: 000 USD N
Pre-Encumbrance: 000 USD PS 5
Associate Revenue 0.00 usbD
Available Budget
Without Tolerance 78540788 USD Percent  (42.11%)8 Forecasts
With Tolerance 78549788 USD Percent  (42.11%)3
Budget Exceptions
Exception Errors 0 Exception Warnings 0
OK
Activity Log
Ledger APP_BUD
Activity Log
I 5« fiew Al
|
| m;‘ E:::"""‘ Document ID :;'m Location Fund g;" gg{,':‘ Program gu“:{;" Project G‘:‘?"’“‘"“ Budget Period
SO 299 Journal ID. 1802SAL N 2 1 243 1101 1 493030 1060 00 2018
R % 300 Journal ID: 1802SAL N 2 1 243 1101 1 493030 1060 00 2018
o
X 301 Journal ID: 1802SAL N 2 1 243 1101 1 493030 1060 00 2018
|
OK
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Budget Info, Exceptions, & Reports
Review Budget Overview

13. Click > Display Chart
14. Click > OK to return to Inquiry Results page

Budget Details

I Display Chart
Ledger Amounts
Max Rows 100
. . Attributes
Budget: 186,528.00 USD ® L
Parent / Children
Expense: 107.978.22 USD & <5 Associated Budgets
Encumbrance: 0.00 USD Y )
Pre-Encumbrance: 0.00 USD Y Y
Associate Revenue 0.00 usb
Available Budget
Without Tolerance 78549.785  USD Percent  (42.11%)% Forecasts
With Tolerance 78.549.78 % usD Percent  (42.11%)%
Budget Exceptions
Exception Errors 0 Exception Warnings 0
OK
Budget Details
Hide Chart L
Ledger Amounts
Max Rows 100
Budget: 186,528.00 USD ® 4 Atrbutes
Parent / Children
Expense: 107.978.22 USD & <3 Associated Budgets
Encumbrance: 0.00 USD Y <3
Pre-Encumbrance: 0.00 USD Y <3
Associate Revenue 0.00 usD
Available Budget
Without Tolerance 7854078 USD Percent  (42.11%)% Forecasts
With Tolerance 78,549.78 UsD Percent (42 11%)F-
Budget Exceptions
SRS n ekilcsalaioce "
Chart
Activity as a Percentage of (Budget + Associated Revenue)
120
10
8
-3
]
§ ©
H
&

2 Balance
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Budget Info, Exceptions, & Reports
Review Budget Overview

15. Click > [:‘:l1 to view Budget Transaction Types
16. Click > Return

Inquiry Results
Business Unit  PCCD1
Ledger Group  APPROP
Type of Calendar  Detail Budget Period
Amounts in Base Currency  USD
Revenue Associated:

Return to Criteria Max Rows 100 Display Options Search

Ledger Totals (100 Rows)

Budget 18,377,848.88 Net Transfers -168,257.20
Expense 9,578,101.90
Encumbrance 0.00
Pre-Encumbrance 0.00
Budget Balance 8,799,746.98
Associate Revenue 0.00
Available Budget 8,799,746.98
Budget Overview Results
5 Q 1-100 0f 100 v View Al
5 ChartField1 Fund Code Cost - Object Account Prog
Ledger Group Location Description Fund Description Ctr Department Description Code Description Program Des!
1B APPROP 2 ollege 11 General Restricted 543 Student Services - EOPS 1101 Instructor 1 4
Alameda Fund
Budget Transaction Types X
. Fund Cost Object Program . . - §
L r @@bup  Location Code Sy e Code Activity Suffix  Project Accounting Line  Budget Period
AP} 2 1" 243 1101 1 493030 1060 00 2018
Budget Transaction Type Budget Amount Base Currency
Original 186,528.00 USD
Adjustment 0.00 USD
Transfer Adjustment 0.00 USD
Transfer Original 0.00 USD
B Closing 0.00 USD
| Roll Forward 0.00 USD
3
Ie Total Budgeted Amount 186,528.00 USD
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Budget Info, Exceptions,
Review Budget Overview

17. Click > Return to Criteria hyperlink

& Reports

Inquiry Results

Return to Criterial

Ledger Totals (100 Rows)

Budget

Expense
Encumbrance
Pre-Encumbrance
Budget Balance
Associate Revenue

Available Budget

Budget Overview Results

5 Q

Ledger Group Location

1B B APPROP 2

Business Unit

Ledger Group

Type of Calendar

Amounts in Base Currency
Revenue Associated:

Max Rows
18,377,848.88
9,578,101.90
0.00
0.00
8,799,746.98
0.00
8,799,746.98
Deserpion  Fund
College of 1
Alameda

PCCD1
APPROP
Detail Budget Period
usD
100 Display Options
Net Transfers
E‘:s‘grﬁ;:idoz g:rSt Department Description

General Restricted

243 Student Services - EOPS
Fund

Search
-168,257.20
1-100 of 100 v
Object Account
Code Description
1101 Instructor

Program

View All

Prog
Des:

@
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Budget Info, Exceptions, & Reports
Review Budget Check Exceptions

In the upgraded ONEPeralta system, use the following steps to
review Budget Check Exceptions.

1. Click > NavBar icon > Navigator

2. Click > Commitment Control > Review Budget Check Exceptions >
General > Budget Journal

6

NavBar: Navigator

&

Hpgll 2 General Ledger
s
:©
Recent Places Journal
Payroll

My Favorites . .
Y Generic Transaction Entry

E Hyperion Budget Exceptions

Navigator

Budget Journal

ONE.:
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Budget Info, Exceptions,

Review Budget Check Exceptions

3. Enter > Required Fields:

a) Commitment Control Tran Date

b) Business Unit
c) Journal Date
d) Process Status
4. Enter > Optional Fields:

a) Commitment Control Tran ID

b) Journal ID
c) Process Instance
Click > Search

ul

6. Select > Journal ID hyperlink

& Reports4

Budget Journal

Enter any information you have and click Search. Leave fields blank for a list of all values.

‘ Find an Existing Value

w Search Criteria

Commitment Control Tran ID

begins with v “

(3)9)

Commitment Control Tran Date | = v :]
Business Unit | = v PCCD1 Q
Journal ID | begins with v Q
Journal Date | = v :j
Process Instance | = v
Process Status | = v v
Search lear Basic Search & Save Search Criteria

Search Results

View Al

Commitment Control Tran ID Commitment Control Tran Date Business Unit Journal ID

4

4 201-2830f283 ¥

Journal Date UnPost Sequence Process Instance Process Status

0000546669 03/16/2018 PCCD1 0000065040 03/15/2018 0 1573334 Error
0000547877 03/26/201 PCCD1 0000065238 | 03/26/2018 0 1583343 Error (é\
0000547878 03/26/2018 PCCD1 0000063115 ' 12/04/2017 0 1583347 Error

UYL IE Ty USIZ01ZU roCU LY Kz s A Y folE R ) EInol
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Budget Info, Exceptions, & Reports
Review Budget Check Exceptions

7. Click > Budget Check icon ( 7))

GL Journal Exceptions ‘ Line Exceptions
Business Unit PCCD1 Journal ID 0000062495 7 Date 03/22/2018
*Exception Type | Error Override Transaction 2
Maximum Rows 100 More Budgets Exist
Search Advanced Budget Criteria
Budgets with Exceptions
H Q 1-10f1 v View All
Budget Override Budget Chartfields I
Details Business Unit Ledger Group Exception More Detail oBverride Transfer
udget
1 4 PCCD1 |
Budget Checking has logged 'Error' Exceptions. (18021,1093)
Return to Search Notify
GL Journal Exceptions | Line Exceptions Budget Checking completed with Error exceptions for this document. I

FUTURE
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Budget Info, Exceptions, & Reports
Review Budget Check Exceptions

8. Click > Budget Override to review the Exception

GL Journal Exceptions ‘ Line Exceptions

Business Unit PCCD1

*Exception Type | Error ';
Maximum Rows 100

Search

Budgets with Exceptions

g5 Q
Budget Override gudget Chartfields I
Details Business Unit Ledger Group
1 C} PCCD1 APPROP

Save Return to Search Notify

GL Journal Exceptions Line Exceptions

Journal ID 0000062495~
Override Transaction
More Budgets Exist

Advanced Budget Criteria

Exception

Error

FUTURE
PERALTA

ONE

Journal Date  03/22/2018




Budget Info, Exceptions, & Reports
Review Budget Check Exceptions

9. Click > Go To icon ( &)
10. Click > Go to Budget Exceptions

Business Unit PCCD1 Journal ID 0000062495~ Journal Date  03/22/2018

*Exception Type [ Override Transaction ] e

Maximum Rows 100 More Budgets Exist

Search Advanced Budget Criteria

Budgets with Exceptions

H Q 1-10f1 v View All
Budget Override Budget Chartfields 13
Details Business Unit Ledger Group Exception More Detail %V:J;:te Transfer
1 S PCCD1 APPROP Error More Detail

Save Return to Search Notify

GL Journal Exceptions | Line Exceptions

"

Please select one of the following links:
lGo to Budget Ezceptionsl
o to Budget Inquiry

] Cancel |

T

ONE
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Budget Info, Exceptions, & Reports
Review Budget Check Exceptions

11. Click > Budget Journal Exceptions to review error

Ve
(11
m Budget Journal Exceptions Budget Line Exceptions

Business Unit PCCD1 Journal ID  0000063115%= Joumnal Date 12/04/2017
*Exception Type | Error v Override Transaction [ L5 LG
Maximum Rows 100 More Budgets Exist

Search Advanced Budget Criteria

Return to Search Previous in List Next in List Notify

Budget Journal Exceptions Budget Line Exceptions

PERALTA A
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Budget Info, Exceptions, & Reports
Budget Vs. Actual Report

In the upgraded ONEPeralta system, use the following steps to
run the Budget Vs. Actual Report. This is a custom report.

1. Click > NavBar icon > Navigator
2. Click > PCCD Custom Pages > PCC Reports> GL Reports > Budget

Vs. Actual Report

€

NavBar: Navigator

| O@

GL Reports

Bl :
Budget Vs. Actual Report

Recent Places

Budget vs Income Statement Rpt

My Favorit
S — Income Statement by Fund Rpt

E Trial Balance by Fund Report

Navigator

Balance Sheet by Fund Report

PERALTA I
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Budget Info, Exceptions, & Reports

Budget Vs. Actual Report

3. Click > Add a New Value
4. Click > Run Control ID
5. Click > Add

Budget Vs. Actual Report

3
Find an Existing Value Add a New ValueCI>
@
Run Control ID| \I/

Add

Find an Existing Value | Add a New Value

PERALTA -
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Budget Info, Exceptions, & Reports
Budget Vs. Actual Report

6. Enter > Required Fields:

a)
b)
c)
d)

Business Unit

Ledger Group

Fiscal Year

From and To Accounting Period

7. Enter > Optional Fields:

a)
b)
C)
d)
e)
f)
g)
h)

Location

From and To Fund Code
From and To Cost Center
From and To Object Code
From and To Program Code
From and To Activity Suffix
From and To Project ID
From and To Accounting Line

8. Click > Save

ONE

Budget vs. Actual Report

Process Monitor Run

Run Control ID BUD Report Manager
Run Control Parameters

*Business Unit: PCCD1 |Q

*Ledger Group: APPROP Q

Location: Q

From Fund Code: Q To Fund Code:

From Cost Center: Q To Cost Center:

From Object Code: Q To Object Code:

From Program Code: Q To Program Code:
From Activity Suffix: Q To Activity Suffix:
From Project ID: Q To Project ID:

From Accounting Line: Q To Accounting Line:
*Fiscal Year:

*From Accounting Period: *To Accounting Period:

00

Q
Q
Q
Q
Q
Q
Q

=Y

+ Add 2| Update/Display

PERALTA

T
o |
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9. Click > Run

10. Select > Budget Vs. Actual Report

11. Click > OK

Budget Info, Exceptions, & Reports
Budget Vs. Actual Report

Budget vs. Actual Report

Run Control ID BUD

Run Control Parameters

*Business Unit: PCCD1 |Q
*Ledger Group: APPROP
Location:

From Fund Code:

From Cost Center:

From,

Fron

From

Fron

Fron

*Fisc

*Fron

5 Save

ONE

Report Manager

To Fund Code:

To Cost Center:

Process Monitor

Process Scheduler Request

UserID FUNC_2

Run Control ID BUD

Server Name

Run Date 04/26/2018

Recurrence

Cancel

FUTURE

PERALTA

Run Time 1:57:00PM

PCC_BDACT_AE  Application Engine

Reset to Current Date/Time

*Format Distribution

v || TXT v | Distribution




Budget Info, Exceptions, & Reports
Budget Vs. Actual Report

12. Click > Process Monitor
13. Review > Run Status is Success and Distribution Status is Posted

Budget vs. Actual Report

Run Control ID BUD

Report Manager

Process Monitol

Process List Server List

View Process Request For

userp FUNC_2 Q
Server M

Run v
Status

Process List

5 Q
Select Instance Seq.
1588488
1588417
1588347
1588335

Type
Name

Distribution Status

Process Type

Application Engine

Application Engine

Application Engine

Application Engine

v Last

Q Instance From

v

Process Name

PCC_BDACT_AE

PO_AUTO_SRC

GL_YC

GL_RECN

1 Days v

Instance To

¥ Save On Refresh

User

FUNC_2

FUNC_2

FUNC_2

FUNC_2

Run Date/Time

04/26/2018 1:57:00PM PDT

04/26/2018 12:36:13PM PDT

04/26/2018 9:51:20AM PDT

04/25/2018 9:46:31PM PDT

\Qw All

Details

Details

Details

Refresh
1-40f4 v
Distribution \1 3

Run Status Status
Queued N/A
Success Posted
Success Posted
Success Posted

Details

FUTURE
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Budget Info, Exceptions, & Reports
Budget Vs. Actual Report
14. Click > Report Manager

15. Click > Administration tab
16. Click > Budget Vs. Actual Report link to view & download the report

Budget vs. Actual Report

Run Control ID BUD Run
List Explorer Administrab‘ Archives
View Reports For
UseriD FUNC_2 Type v Last Refresh
Status Y| Folder Y Instance to
Report List
H Q 1-60f6 v View All
Report Prcs . Request .
Select D TP Description Date/Time Format Status  Details
04/26/2018 Text Files )
1237414 1588491  Comm. Cntrl. Budget Processor @1:59:08PM ("xt) Posted  Details
Microsoft
1237412 1588488 PCC_BDACT - Budget_Vs_ActuaI_Repon.xlsyofuzélzm8 Excel Files Posted Details
1:58:26PM e
04/26/2018 Text Files .
1237411 1588488 Bymet Vs. Actual Report 1:57:33PM (" 1xt) Posted  Details
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Budget Info, Exceptions, & Reports
Budget Vs. Income Statement Report

In the upgraded ONEPeralta system, use the following steps to
run the Budget Vs. Income Statement Report. This is a custom

report.

1. Click > NavBar icon > Navigator

2. Click > PCCD Custom Pages > PCC Reports> GL Reports > Budget

Vs. Income Statement Report

6

Recent Places

My Favorites

NavBar: Navigator

GL Reports

‘OI O@

Budget Vs. Actual Report

Budget vs Income Statement Rpt

Navigator

Income Statement by Fund Rpt

Trial Balance by Fund Report

Balance Sheet by Fund Report

ONE
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Budget Info, Exceptions, & Reportsw

Budget Vs. Income Statement Report

3. Click > Add a New Value
4. Click > Run Control ID
5. Click > Add

Budget Vs. Actual Report

3
Find an Existing Value Add a New VaIueCI>
@
Run Control ID| \I/

Add

Find an Existing Value | Add a New Value
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Budget Info, Exceptions, & Reports
Budget Vs. Income Statement Report

6. Enter > Run Control Parameters:

a)
b)
c)
d)
e)
f)
g)
h)

Business Unit

Fund Code Selection

Tree Name

Tree Node

Fund Values From and To
From and To Location ID
Fiscal Year

From Period and To Period

7. Click > Save

Budget Vs. Income Statement Report

Run Control ID BUD Report Manager

Process Monitor

Run Control Parameters

*Business Unit PCCD1 |Q

*Fund Code Selection| By Tree Name/Tree Node v

*Tree Name Q *Tree Node
*From Location Q *To Location
*Fiscal Year

*From Period *To Period
N\

0

(&)

TR
‘4l Save

Run

—+ Add

ONE

FUTURE
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Budget Info, Exceptions, & Reports
Budget Vs. Income Statement Report

8. Click > Run

9. Select > Budget Vs. Income Statement Report
10. Click > OK

Budget Vs. Income Statement Report

Report Manager  Process Monitor Run :

Run Control ID BUD

Run Control Parameters

*Business Unit PCCD1 |Q
*Fund Code Selection| By Tree Name/Tree Node v
*Tree Name Q *Tree Node
*From_Location L Q *To L ocation Q
.. | Process Scheduler Request
Fis
. UserID FUNC_2 Run Control ID BUD
Fro
Server Name' vi Run Date 04/26/2018 e
= Reset to Current Date/Time
= Save Recurrence v Run Time 2:26:43PM e
one Q =
ftion Process Name Process Type *Type *Format Distribution
Budget vs Income Statement Rpt PCC_BD_IN_AE Application Engine | Web v || TXT v | Distribution

19

OK Cancel
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Budget Info, Exceptions, & Reports
Budget Vs. Income Statement Report

11. Click > Process Monitor
12. Review > Run Status is Success and Distribution Status is Posted

Budget Vs. Income Statement Report

Run Control ID BUD Report Manager | Process Monitoro Run

Process List Server List

View Process Request For

User D FUNC_2 Q Type v Last v 1 Days v Refresh
Server M Name Q Instance From Instance To

Run M Distribution Status v| ¥ Save On Refresh
Status

Process List

5 Q

1-40f4 v w All
Select Instance  Seq. Process Type Process Name User Run Date/Time Run Status 2:::2:““” @
1588488 Application Engine PCC_BDACT_AE FUNC_2 04/26/2018 1:57:00PM PDT Queued N/A Details
1588417 Application Engine PO_AUTO_SRC FUNC_2 04/26/2018 12:36:13PM PDT Success Posted Details
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Budget Info, Exceptions, & Reports
Budget Vs. Income Statement Report

13. Click > Report Manager
14. Click > Administration tab

15. Click > Budget Vs. Income Statement Report link to view &
download the report

Budget Vs. Income Statement Report

Report Manager :ocess Monitor

Run Control ID BUD Run
List Explorer Administra}: l/ Archives
View Reports For
UseriD FUNC_2 Type v Last v Days v Refresh
Status Y| Folder Y | Instance to
Report List
5 Q 1-60f6 v View All
Report Prcs s Request .
Select D T Description Date/Time Format Status  Details
1237414 1588491  Comm. Cntrl. Budget Processor ﬂég%ﬁgﬁ (T,et’:t;: €S posted  Details
&4/26/2018 eroeon
1237412 1588488 PCC_BDACT - Budget_Vs_Actual_Report.xlsx 1:58:26PM Excel Files Posted Details
o Lxls)
1237411 1588488 ot Vs. Actual Report ?f‘égggg}f (T,etxxtt;: €S posted  Details
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